


Guidelines for Using the 
Final Report Template
May 2026

[image: Logo for Iowa Department of Transportation]













	6
[bookmark: _Toc42327121]Acknowledgments
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· 508-Compliant Research Report Template
· Section 508 Accessibility: Guidelines for Using the Research Report Template 
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List of Abbreviations and Acronyms
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ICT	information and communication technology
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NTL	National Transportation Library
ORCID	Open Researcher and Contributor ID
PDG 	Project Development Group 
ROSA P	Repository & Open Science Access Portal
SPR	State Planning & Research
STIC	State Transportation Innovation Councils
TAC 	Technical Advisory Committee
WCAG	Web Content Accessibility Guidelines



[bookmark: _Toc206487104][bookmark: _Toc42327122]Introduction 
Researchers participating in the Iowa Department of Transportation (Iowa DOT) research program are required to use the agency’s Microsoft Word report template when preparing the research reports that serve as final deliverables when a research project concludes. The guidance below addresses the most significant elements of the Final Report Template and offers information to supplement the instructions appearing in the template. 

Iowa DOT developed the report template to encourage consistency in the general content and appearance of the final reports describing research sponsored by the agency and its partners. Use of the report template also assists authors with complying with the federal accessibility requirements presented in Section 508 of the Rehabilitation Act of 1973. 

Section 508 requires agencies to make information and communication technology (ICT) products accessible to all users, including those with visual or other impairments. ICT products include electronic research reports. Iowa DOT submits its research reports for publication on several online platforms, including the National Transportation Library’s (NTL’s) Repository & Open Science Access Portal (ROSA P), a digital library that houses full-text publications, datasets, and other resources. NTL requires that all publications hosted on ROSA P comply with Section 508 requirements. 

Reviewing this guidance document before beginning work on a final report and carefully reviewing the instructions embedded within the report template as writing proceeds, will help authors prepare and deliver final report files that comply with Iowa DOT’s expectations and federal accessibility requirements. 

      	Iowa DOT requires research teams to use its Final Report Template for all reports produced for Iowa DOT-funded research. The report template and these guidelines are available for download at the Iowa DOT website. 
[bookmark: _Toc206487105]Using the Final Report Template
Each chapter of the report template provides guidance for recommended content. Selected chapters also include instructions to aid authors in meeting Section 508 accessibility requirements. All instructions should be removed from the final report before submitting the document to Iowa DOT.

 	Reports that are not formatted according to these guidelines may be returned to the authors for revision.

Instructions or examples for formatting the following report elements are provided in the report template:
Disclaimer and Statement of Non-Disclosure
Technical Report Documentation Page
Acknowledgments
Abbreviations and acronyms
Citations and in-text references to citations
Color and appropriate color contrast
Columns
Equations
Figures and images
Hyperlinks
Lists
Tables
Text boxes

Other tips to consider when using the report template:
· Do not alter the template’s styles for fonts, type size, paragraph justification, page margins, page size, headers, or footers.
· Do not use blank spaces, blank lines, and manual tabs for formatting. Instead, use Word’s formatting tools.
· Do not add blank pages as spacers.
· Avoid using footnotes.

 	Use the following naming convention for PDF submissions: 
ResearchProjectNumber_DeliverableType_ProjectTitle.pdf 
Example: RE26007_FinalReport_HowToBuildABridge.pdf
Example: RE26007_TechTransfer_HowToBuildABridge.pdf

These guidelines do not provide technical writing and style guidance. Refer to the Iowa.gov Voice, Tone & Style Guide for such guidance.
[bookmark: _Toc206487106]Using Styles in Word Documents
The report template uses the Styles feature in Word to apply formatting for headings, lists, captions, and other components of a research report. Using this feature provides a consistently formatted document and also creates an accessible document structure that is recognized by screen readers and other assistive technology.

 	Using the built-in Styles feature is required with the report template. Styles are noted at the bottom of the page for each report element or chapter.

[bookmark: _Toc206487107]Complying with Accessibility Requirements
Once the final report is drafted, authors are required to check the document’s accessibility and repair any issues before submitting the report to Iowa DOT. Conducting these accessibility checks is explained in Chapter 3. 

Embedded instructions in the report template help authors avoid common accessibility pitfalls when creating a Word document. Following the best practices below will also help ensure a final report complies with federal accessibility requirements: 
Provide a descriptive filename for the Word document. Do not include spaces or special characters in the filename. (Examples of 508 accessible filenames: filename.docx or file_name.docx.)
Use the document’s built-in headings and styles to organize content. Use of these standard program features makes it easier for the document creator to organize content and ensures readability for the screen reader by establishing a logical reading order.
Use simple tables with column headers. Don’t use split or merged cells, or leave cells blank. Screen readers count table cells as they read content. Nesting tables, splitting cells, or blank cells confuse this logical reading operation.
Include alternative text for all images, figures, graphics, and equations. Often referred to as “alt text,” alternative text is a text-based description of all visual content in a document that allows a screen reader to briefly explain the most important aspects of each object to users with visual impairments.
Write hyperlink text that is unambiguous and meaningful. Don’t use “learn more” or “click here.” A screen reader can only see the hyperlink text, so it must include enough description for those with visual impairments to understand what can be found at the link’s destination.
Don’t use color alone to convey information. People who are colorblind or have low vision won’t be able to distinguish between colors to understand the information presented. If color is used to convey meaning, an additional method—such as words or symbols—must be used to ensure more people can access the information.
Select text and background colors with sufficient contrast. A high level of contrast between text and background will enable more people to access the content.


[bookmark: _Toc206487108]Elements of the Final Report Template 
[bookmark: _Toc206487109]Introduction
The following report elements are included in the report template in the order in which they appear in the report. 
· Report cover (prepared by Iowa DOT)
· Front matter
· Disclaimer 
· Statement of Non-Disclosure
· Instructions for Completing the Technical Report Documentation Page
· Technical Report Documentation Page (Form DOT F1 700.7)
· Title page
· Acknowledgments 
· Metric conversion chart (optional)
· Table of contents (automatically generated in the template) 
· List of tables (if tables are used; automatically generated in the template)
· List of figures (if figures are used; automatically generated in the template)
· List of equations (if equations are used; automatically generated in the template)
· List of abbreviations and acronyms 
· Executive summary 
· Body of the report
· Chapter 1
· Subsequent chapters
· Final chapter (conclusions)
· References
· Appendices
· Appendix A: Implementation
· Appendix B: Equipment and Materials Specifications (optional)
· Other appendices (as needed)

Selected report elements are addressed in more detail below.
[bookmark: _Toc206487110]Report Cover
The research team prepares the report cover using the Word template that is provided as a supplement to the Final Report Template. See the instructions below for inserting an appropriate image in the cover page and including the appropriate text and logo(s).  

Inserting a custom image. Follow the steps below to swap out the template photo with a photo or other image that is appropriate for the research project: 
1. Click on the very left edge of the image appearing under the chevrons.
2. [image: ]From the top ribbon, select the Shape Format tab.
3. Click on Shape Fill (appears with a paint bucket icon) to open a new menu.
4. Click on Picture to open a new menu. From the Insert Pictures menu, click on From a File to browse files on your computer. 
5. Locate the appropriate image and click on Insert.

Updating other cover page elements. Make other changes to the cover page to reflect the current project:
· Update the month and year, as appropriate, to indicate the date of publication. 
· Retain or insert the logo for the project sponsor(s). Delete any other logos appearing in the template.

Describing the report. To eliminate a common accessibility issue found in PDFs, authors will add the document properties information (report title, author, and tags) to the Word version of the final report using the Info option of the File tab. This information will appear in the PDF generated from the Word file, with tags appearing as keywords in the PDF.

Authors are also asked to provide keywords on the Technical Documentation Report Page (see Box 17. Key Words).
 	To double-check that the document descriptions have transferred from the Word file to the PDF, in Adobe Acrobat, click on Document properties at the bottom of the main menu.
[bookmark: _Toc206487111]Front Matter
Sample text and recommended approaches for elements of the front matter are included in the report template. Selected front matter elements are discussed in more detail below. 
Instructions for Completing the Technical Report Documentation Page: 
Identifying sponsoring agencies. Pay careful attention to differences in entry in the Technical Report Documentation Page that are based on the entity sponsoring the research.
 	Research teams completing projects sponsored by the Accelerated Innovation Deployment (AID) Demonstration program will not use Iowa DOT’s report template and this associated guidance. Instead, these projects require use of a report template provided through the AID program. Consult with the Iowa DOT project manager for more information.

Complying with the ORCID requirement. Final report authors are required to provide an ORCID (Open Researcher and Contributor ID) number and ORCID URL. An ORCID number allows for identification, linking, and discovery among academic authors and contributors. Researchers can complete the five-step online ORCID registration to obtain a free, unique, persistent identifier through ORCID.
Title page. The sample title page appearing in the template indicates the minimum amount of identifying information to include in a title page. This includes:
· Report title
· By:
· Author name(s)
· Name of the performing organization
· Prepared for: Name(s) of the sponsoring organization(s):
· Iowa DOT (includes State Planning & Research (SPR), pooled funds, and state-funded research)
· [bookmark: _Hlk188860075]Iowa Highway Research Board (IHRB) 
· State Transportation Innovation Councils (STIC)
· Month and year of the report’s publication
· The words “Final Report” in bold text
· Project number, if applicable
· Logo(s) of the sponsoring organization(s)
· Logo of performing organization (if desired)
Metric conversion chart. Include this in the front matter only if the final report includes metric references.
List of abbreviations and acronyms. This list compiles terms that have been defined, or abbreviated, in parentheses upon first use in the final report. Use the sample in the template as a model to create a list of only those abbreviations appearing in the final report. 
[bookmark: _Toc206487112]Body of the Report
Chapter 5. Conclusions. In addition to summarizing the project’s key findings and conclusions, this chapter provides a high-level discussion of the Research Implementation Plan that will be included in the final report as Appendix A.
[bookmark: _Toc206487113]Appendices
Appendix A: Implementation. The Research Implementation Plan presents recommendations for implementing research project findings. Summarized below are key tasks and the parties responsible for addressing the implementation of research results and documenting a plan for implementation. 

Planning for implementation begins with the project proposal. When preparing its research proposal, the research team is required to allocate time and budget to an Implementation Plan task that is completed during the same period as preparation of the final report (typically, the final three months of the research project).

Addressing implementation during the research process. The research team will consider implementation as research progresses and include implementation on the agenda for periodic meetings with the Technical Advisory Committee (TAC). 

As the research project nears completion, after the development of recommendations and three months before delivery of the final report and expiration of the contract, the research team will schedule an implementation plan development meeting to address the potential for implementation of research findings. The Research Implementation Plan will be used to guide discussion about next steps for applying research results.
Completing the Research Implementation Plan. After the implementation plan development meeting, the TAC members will complete agency-dependent Research Implementation Plan(s). After briefly describing the implementation plan and how its results will benefit their agency and its stakeholders, the Research Implementation Plan requires the TAC members to:
· Identify any other stakeholders who are not members of the TAC but must provide input into the implementation of project results. If needed, invite these individuals to review or assist with final Research Implementation Plan development. 
· Identify the major tasks that will be required to implement findings. 
· Present potential challenges or barriers to implementation along with possible mitigation measures. 
· Describe expected benefits, including possible assessment metrics.
· Identify training needs, including the pool of potential trainees, and the nature and extent of the training.
· Highlight gaps in findings and recommend areas for future research. 

Publishing the Research Implementation Plan. The TAC will provide the completed Research Implementation Plan(s) to the research team for inclusion in the final report as Appendix A: Implementation. A copy of the Research Implementation Plan(s) will also be provided to Iowa DOT Research & Analytics Bureau.  

Appendix B. Technical Brief. A Tech Transfer Summary is prepared at the same time as the final report. Like the final report, this technical brief is reviewed by the TAC and the Iowa DOT Project Manager. More information, including a template, is provided in the Final Report Template.

Appendix C. Other Project Deliverables. Prepare and present a list of the project deliverables the research team has prepared for this project. This list might include: 
· Database
· Equipment purchased with project funds
· Manual or guide
· Report (other than this final report)
· Computer program, software or other online tool
· User or instruction manual 
· Photographs and other image files
· Video or other audio-visual material
· Data management plan
All documents must meet accessibility requirements. Chapter 3 presents accessibility requirements and describes how to meet them.

Appendix D. Equipment and Material Specifications. Include this appendix only if applicable. This appendix is required if the project includes any purchase of equipment or tangible items. Content appropriate for this appendix includes materials lists, scanned material certifications, scanned equipment flyers, equipment costs, warranties, and similar content. 

[bookmark: _Accessibility]A disposal agreement may be required if the project requires purchase of equipment or nonconsumable tangible items. Refer to the Contract Agreement for specific disposal requirements or contact the project manager.

[bookmark: _Accessibility_1][bookmark: _Toc206487114]Accessibility
Final reports submitted to Iowa DOT must meet the agency’s expectations for report content, as described in the Final Report Template, and the federal accessibility requirements defined in Section 508 of the Rehabilitation Act of 1973. 
 	Iowa DOT requires the submission of both Word and PDF versions of a final report. Only the PDF will be submitted to various online platforms for public access.

To meet Section 508 accessibility compliance requirements, authors must test final reports in both the Microsoft Word and Adobe Acrobat (PDF) formats using accessibility checkers built into Microsoft Word and Adobe Acrobat. Authors are required to address any errors and failures in these documents before submitting final documents to Iowa DOT. Tools and practices for checking accessibility are provided below.
 	Authors are advised to make a Word file as compliant as possible before converting the Word file to a PDF. A carefully prepared Word file will limit the amount of remediation needed to make the PDF generated from that Word file accessible. 
[bookmark: _Toc206487115]Checking Accessibility in Microsoft Word Documents
[bookmark: _Toc206487116]Engaging the Microsoft Accessibility Checker
Recent versions of Microsoft products, including Word, Excel, Outlook, and PowerPoint, include accessibility checkers described in Rules for the Accessibility Checker available on the Microsoft Support site. 

The Accessibility Checker is a built-in tool accessed through the Review menu of a Word document. 
 	If the Accessibility Checker does not appear in the Review tab, the software program is likely an older version and accessibility is reviewed differently than the procedure described below.

To keep the accessibility checker in Word running while working on a document (recommended): 
Click on the File menu and select Options. 
Click on Accessibility. Check the box next to Keep accessibility checker running while I work. 
The Accessibility submenu allows users to select other preferences:
· Feedback options. Provide feedback with sound or animation.
· Application display option. Determine the ScreenTip Style and whether to show shortcut keys and the Start screen when the application starts.
· Automatic Alt Text. Use of automatically generated alt text is discouraged because it is often inaccurate or inadequate. While this option is not recommended, if you choose it, proceed with caution and plan to manually review each automated alt text entry for appropriateness, revising as needed.
· Document display option. Determine whether to expand all headings when opening a document.
 	Some accessibility issues, such as color and reading order of text, must be checked manually.
[bookmark: _Toc206487117]Using the Microsoft Accessibility Checker
1. On the ribbon of the Microsoft 365 software program, select the Review tab. 
2. Select the upper part of the Check Accessibility split button. The Accessibility Assistant pane opens to the right of the screen. 
3. Review and address findings under the following categories that appear in the Accessibility Assistant pane:
· Color and contrast
· Media and illustrations
· Tables
· Document structure
· Document access

Follow the prompts to address each item until no accessibility issues are found.
[bookmark: _Accessibility_for_Older][bookmark: _Toc206487118]Additional Guidance
The Section508.gov website offers resources to assist authors in meeting accessibility requirements, including a 17-point checklist for Microsoft Word 2016 that can be used to test for accessibility results. Topics in the checklist are summarized below with references to relevant portions of the report template, where applicable.
Document 
1. The Word document (.docx) is saved with a descriptive filename.
· The file type is Word document (.docx) format.
· The filename identifies the document or its purpose. 
· Do not include spaces or special characters in the filename. Examples of accessible filenames: filename.docx or file_name.docx.
Headings
2. The document uses Microsoft Word heading styles.
· Headings in the Navigation pane mirror the headings in the document and the document’s visual outline.
· Document heading styles are described and illustrated in Chapter 1 of the report template.
Lists
3. Lists are formatted correctly.
· Bulleted and numbered lists are described and illustrated in Chapter 4 of the report template.


Columns
4. Columnar content is formatted correctly. 
· Creating accessible columns is addressed in Chapter 4 of the report template.
Layout Tables
5. Layout tables have the correct format.
· Authors are encouraged not to use layout tables to format content on a page.
Language
6. Intended languages are formatted in the documented text.
· In the Review tab, select the drop-down menu in the Language group to set the language to English (United States).
Links
7. Link names are descriptive.
· Link names describe destination/purpose or describe context.
· Links have unique names.
· Descriptive hyperlinks are discussed in Chapter 4 of the report template.
Headers, Footers, Watermarks
8. Vital information in headers, footers, and watermarks is duplicated in the text.
· Screen readers may not read the information in headers and footers. Watermarks cannot be made accessible. Copy any essential information in headers, footers, and watermarks and include it in the report.
Data Tables
9. Data tables are created using built-in features.
· Tables are not pictures and free of merged or split cells.
· Tables repeat their header row.
· Data tables are described and illustrated in Chapter 2 of the report template.
Images and Other Objects
10. Images and other objects have alternative text.
· Accessibility Checker does not report “Image or object not inline.”
· Alternative text (alt text) is described and illustrated in Chapter 3 of the report template. 
Text Boxes
11. Images, objects, and text boxes are in line with the text.
· Text boxes do not generate “Image or object not inline” warnings.
· To make images, objects, and text boxes in line with text, click on the element and then select the Layout tab. In the Arrange group, open the drop-down menu under Position and select In Line with Text.
· Creating an accessible text box is addressed in Chapter 4.
Colors and Sensory Characteristic
12. Color and other visual characteristics are also textually described.
· Meaning of color or other sensory characteristics is duplicated in text.
· Appropriate use of color is discussed in Chapters 2 and 3 of the report template.


Color Contrast
13. The color contrast between text and background is sufficient.
· Text and Large Text (including images of text) pass the Colour Contrast Analyser.
· WebAIM’s contrast checker is a helpful online tool discussed in Chapters 2 and 3 of the report template. All text in the document should pass the WCAG AA test criteria.
· The WebAIM tool above requires colors to be input in hex format. To convert other common color formats like RBG, CMYK, and HSL to hex, the Convert A Color is a helpful tool. 
Audio, Video, and Synchronized Media
14. Embedded files are accessible.
· This item relates to embedded multimedia files. See the accessibility checklist for more information.
Forms
15. The document has no forms.
· Fillable form fields are excluded from the document.
Flashing Objects
16. The document has no flashing objects.
Alternative Accessible Version
17. An alternative accessible version is provided.
[bookmark: _Toc206487119]Checking Accessibility in Adobe Acrobat Documents (PDFs)
After a Word file has been evaluated for compliance and remediated, as needed, authors must convert the Word document to PDF and check accessibility requirements in the PDF.

The following is excerpted from the October 2024 version of the Adobe guidance for Acrobat 2020 Create and Verify PDF Accessibility (Acrobat Pro). Step-by-step procedures for resolving specific issues identified by the checker but not represented below are available in the Adobe accessibility guidance.
1. Open the PDF, and then, from the global bar in the upper left, select All tools, select View more, and then select Prepare for accessibility.
Prepare for accessibility panel with a list of available actions appear on the left panel. 
2. From the left panel, select Check for accessibility. 
3. From the Accessibility Checker Options dialog, select the options as required and then select Start Checking.
4. Once the check is complete, it displays a panel on the right that lists the accessibility issues. Select each issue type drop-down to view the details and make fixes, as suggested.
Since the Accessibility Check feature does not distinguish between essential and nonessential content types, some reported issues may not affect readability. We suggest that you review all issues to determine the ones that need correction.
The report displays one of the following statuses for each rule check:
· Passed: The item is accessible.
· Skipped By User: Rule was not checked because it wasn't selected in the Accessibility Checker Options dialog box.
· Needs Manual Check: The Full Check/Accessibility Check feature couldn't check the item automatically. Verify the item manually.
· Failed: The item didn't pass the accessibility check.

In addition to Accessibility Check, Acrobat provides other methods to check PDF accessibility:
· Use the Reflow view to make it easier to check the reading order. This tool temporarily presents the PDF as a single column that is the width of the document pane, making the document easier to read without scrolling horizontally to read the text.
· Use Read Out Loud to experience the document as readers who use the text-to-speech conversion tool experience it.
· Use the Reading Order tool to quickly and easily examine and fix the structure, reading order, and contents of PDF. This tool is intended for repairing PDFs that were tagged using Acrobat, not for repairing PDFs that were tagged during conversion from the Word source file.
[bookmark: _Toc206487120]Additional Guidance
On the federal guidance page Create Accessible PDFs, the Section 508 guidance is most fully developed for Adobe Acrobat Pro. In the PDF Testing Checklist, 23 potential issues are sorted into five topic areas.
Preconditions
A. The PDF is a PDF Portfolio or has attachments.
B. The PDF was generated from Adobe LiveCycle.
C. Scripts 
D. The PDF is tagged.
E. The PDF is an image or contains scanned pages.
Document Properties
1. The PDF have a descriptive filename.
2. Assistive Technology access is enabled.
3. Document language is set.
Structure Tags
4. The tags follow the visual/logical order of the document.
5. The document has decorative content.
6. Vital information in headers, footers, and watermarks is duplicated in the text.
7. Headings are tagged with a heading tag.
8. Lists are tagged correctly.
9. Sections in different languages have a corresponding language attribute.
Objects
10. Images and other objects have alternative text.
11. Data tables.
12. Links and controls.
13. Fillable forms.
14. Color and sensory characteristics.
15. Color contrast.
· WebAIM’s contrast checker is a helpful online tool discussed in Chapters 2 and 3 of the report template. All text in the document should pass the WCAG AA test criteria.
· The WebAIM tool above requires colors to be input in hex format. To convert other common color formats like RBG, CMYK, and HSL to hex, the Convert A Color is a helpful tool. 
Miscellaneous
16. The PDF contains meaningful audio-only, video-only, or multimedia objects.
17. The document has no flashing objects.
18. An alternative accessible version is provided.
 	For more information or instructions about how to address noncompliant formatting, refer to the more detailed federal guidance document PDF Testing and Remediation Guide. While this document is tailored to a different version of Adobe Acrobat (Acrobat DC), the guidance is widely applicable both to the DC and Pro versions.
[bookmark: _Web_Hyperlinks][bookmark: _Toc206487121] Section 508 Resources and Recommended Guidance
The resources below, curated by the Transportation Research and Connectivity Pooled Fund Study, offer support for those new to Section 508 accessibility:
· Colour Contrast Analyser. A free downloadable tool for checking color contrast.
· Contrast Checker. Use this online tool to determine whether there's sufficient contrast between your text and background colors. 
· Create Accessible Digital Products. The Revised 508 Standards include not just information technology tools and systems, but electronic content such as documents, web pages, presentations, social media content, blogs, and certain emails.​
· Creating Accessible PDFs. Adobe shares its online guidance to creating PDFs that meet Section 508 accessibility standards.
· Creating Accessible Tables. An overview of how and why to create accessible tables.
· Everything You Need to Know to Write Effective Alt Text. Microsoft's online guidance for writing alternative text.
· Image Description Guidelines. A comprehensive resource for describing images effectively.
· Section 508 Compliance. The National Oceanic and Atmospheric Administration (NOAA) Library has created and compiled checklists and resources for authors and editorial staff to use when creating accessible documents. 
· Section 508 Training Webinar: Session 1. Developed by the Transportation Research and Connectivity Pooled Fund Study, this session helps research teams prepare a compliant report in Microsoft Word, and tackles the most common errors that occur when documents are converted from Word to PDF. View the presentation slides.
· Section 508 Training Webinar: Session 2. Part 2 of the series developed by the Transportation Research and Connectivity Pooled Fund Study, this session is for researchers who have some knowledge of Section 508 requirements. A detailed discussion of accessibility practices is followed by a question-and-answer segment. View the presentation slides.
· Test for Accessibility. An overview of testing methods and tools to ensure that websites, software, and electronic documents conform with the Section 508 standards.

User support is also available in support forums maintained for Microsoft and Adobe that can be helpful to find guidance for unusual situations.
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